This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2008 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact CA Technologies

Contact CA Support

For your convenience, CA Technologies provides one site where you can access the information that you need for your Home Office, Small Business, and Enterprise CA Technologies products. At [http://ca.com/support](http://ca.com/support), you can access the following resources:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

Providing Feedback About Product Documentation

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

To provide feedback about CA Technologies product documentation, complete our short customer survey which is available on the CA Support website at [http://ca.com/docs](http://ca.com/docs).
Contents

Chapter 1: Introduction ................................................................. 7
Intended Audience ........................................................................... 7
Conventions ..................................................................................... 7

Chapter 2: Using Accounting Chargeback ........................................ 9
Specifying Resource Prices ............................................................. 10
  Entering Prices Interactively ......................................................... 11
  Using Prices from a File ................................................................. 11
  Overview and Example Price File ................................................. 12
Specifying a Value for the Report Title Keyword .......................... 13
Specifying Values for Resource Keywords ..................................... 13
Specifying Identical Prices for Accounting Files ......................... 15
Specifying Different Prices for Accounting Files ....................... 15
Specifying Different Prices for Print Pages ................................. 19
Specifying Different Prices for Allocated Disk Blocks ................ 21
Specifying Report Details in the Price File .................................. 22

Invoking the ADVISE CHARGE_BACK REPORT Command ............ 23
Sample Report ............................................................................... 23

Reporting on Disk Use Information ............................................ 24
Varying Accounting File Contents .............................................. 27
  Reporting on Specific Accounting File Components ................. 28
  Creating Data Files Based on User Name .................................. 28

Chapter 3: Using the DECwindows Motif Interface .......................... 31
Starting the DECwindows Motif Interface .................................... 31
Exiting from the DECwindows Motif Interface ............................. 32
Controlling the DECwindows Motif Interface ............................... 32
  Creating a Report ....................................................................... 32
  Creating a Report with a Specified File Name ......................... 32
Selecting Data and Price Files ..................................................... 33
  Selecting the Accounting Data Files ........................................ 33
  Selecting the Price File .............................................................. 34
  Selecting the Disk Use Data File ............................................... 34
Specifying Time Periods and Details for Reports ....................... 35
  Specifying Time Periods .......................................................... 35
Report Details .............................................................................. 36
Chapter 1: Introduction

This guide explains how to use CA Performance Management for OpenVMS Accounting Chargeback software to generate reports on system use.

This section contains the following topics:

Intended Audience (see page 7)
Conventions (see page 7)

Intended Audience

The Accounting Chargeback software and this guide are designed specifically for the following users:

■ System managers of OpenVMS systems
■ System programmers of OpenVMS systems
■ Computer operators of OpenVMS systems
■ Software Services personnel
■ Services engineers involved with OpenVMS systems management

This guide assumes that the user knows the:

■ OpenVMS operating system
■ OpenVMS system management
■ OpenVMS Accounting Utility
■ OpenVMS Analyze/Disk_Structure Utility

Conventions

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPPERCASE</td>
<td>Uppercase letters indicate the name of a command, a file, a parameter, a procedure, a utility, or an abbreviation for a system privilege.</td>
</tr>
<tr>
<td>lowercase</td>
<td>In format descriptions, words in lowercase indicate parameters or arguments you must supply.</td>
</tr>
</tbody>
</table>
### Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>user input</td>
<td>In interactive examples, this typeface indicates input entered by the user, a system prompt, or displayed system text.</td>
</tr>
<tr>
<td>system prompts</td>
<td></td>
</tr>
<tr>
<td>system displays</td>
<td>Vertical ellipses points indicate the omission of information from an example or command format. The information is omitted because it is not important to the topic being discussed.</td>
</tr>
<tr>
<td>[ ]</td>
<td>In format descriptions, brackets indicate optional elements. You can choose none, one, or all of the options. (Brackets are not optional, however, in the syntax of a directory name in an OpenVMS file specification.)</td>
</tr>
<tr>
<td>...,</td>
<td>In format descriptions, horizontal ellipses points indicate additional parameters, values, or other information that you can enter separated by commas.</td>
</tr>
<tr>
<td>{ }</td>
<td>In format descriptions, braces indicate required elements. You must choose one of the elements.</td>
</tr>
<tr>
<td></td>
<td>In format descriptions, a vertical bar indicates required elements. You must choose one of the elements.</td>
</tr>
<tr>
<td>( )</td>
<td>In format descriptions, parentheses delimit the parameter or argument list.</td>
</tr>
<tr>
<td>Ctrl+x</td>
<td>Ctrl+x indicates that you hold down the Ctrl key while you press another key or mouse button (indicated here by x).</td>
</tr>
<tr>
<td>MB1, MB2, MB3</td>
<td>MB1 indicates the left mouse button. MB2 indicates the middle mouse button. MB3 indicates the right mouse button. (You can redefine the mouse buttons.)</td>
</tr>
</tbody>
</table>
This chapter introduces you to Accounting Chargeback and describes:

- Specifying resource prices
- Invoking the ADVISE CHARGE_BACK REPORT Command
- Sample Reports
- Reporting on Disk Use Information
- Varying Accounting File Contents

Accounting Chargeback uses OpenVMS accounting data to produce system use reports. These reports show the charges for various system resources based on unit prices that you provide. You can use Accounting Chargeback report as an itemized bill or as a general resource use report.

With the Accounting Chargeback you can:

- Produce a single report from multiple accounting files created by the OpenVMS Accounting Utility on a single node or a cluster system
- Charge different prices for resources in different accounting files
- Charge different prices for resources according to printer queue names and accounting files
- Charge different prices for disk use according to volume names and disk use information provided by the OpenVMS Analyze/Disk_Structure Utility
- Generate reports on the basis of single jobs, job types, UICs, user accounts, and grand totals

The following figure shows how Accounting Chargeback works. It creates reports using your input and system data.
Specifying Resource Prices

Accounting Chargeback uses information from accounting log files that you specify. The OpenVMS Accounting Utility creates these log files on an individual system or on each node of a cluster. The Accounting Chargeback software can read data directly from open accounting files on different nodes. Although the main accounting log file, SYSS$MANAGER:ACCOUNTNG.DAT, is created at system initialization, the OpenVMS Accounting Utility enables you to create other data files.

Before generating a report from the accounting data, you choose the system resources that you want to charge for and specify unit prices for them. You can enter these amounts interactively from the terminal; however, it is usually more convenient to place them in a price file.

To report disk use, enter the command ANALYZE/DISK_STRUCTURE/USAGE to generate a disk use file for each disk on which you want to report. Append the disk use files to one file for the Accounting Chargeback software to process.

The ADVISE CHARGE_BACK REPORT command processes the accounting and disk use data with the price file, which contains resource prices. The software creates a report showing a detailed breakdown of charges by individual job or process, job type, UIC, user name, account name, and grand totals.

To use Accounting Chargeback
1. Determine the amounts to be charged for each type of system resource and place these in a price file. See Specifying Resource Prices in the following section for information.
2. Gather disk use information if you want to report on disk allocation charges. See Reporting on Disk Use Information later in this chapter.
3. Process the accounting and disk data with amounts in the price file and generate a report.

This section contains the following topics:
- Specifying Resource Prices (see page 10)
- Invoking the ADVISE CHARGE_BACK REPORT Command (see page 23)
- Sample Report (see page 24)
- Reporting on Disk Use Information (see page 27)
- Varying Accounting File Contents (see page 28)

Specifying Resource Prices

You can specify prices for resources in two ways:
- By listing the prices in a price file
- By entering the prices interactively
This chapter explains how to specify prices from a terminal interface. See Chapter 3, “Using the DECwindows Interface” for an explanation of how to specify prices from the DECwindows interface.

**Entering Prices Interactively**

To enter prices from the terminal, enter the command ADVISE CHARGE_BACK REPORT without specifying a price-file parameter from the command line. If you specify the optional disk-usage parameter, replace the price-file parameter with quotation marks ("’"):  

```bash
$ ADVISE CHARGE_BACK REPORT account-file-spec "" disk-usage-file-spec
```

The following message is displayed:

Enter price and control characters below:

Enter keywords and values according to this format:

```
keyword = value
```

For example:

```
TITLE = 'Charges for Today'
PAGEFAULT_PRICE = 0.00008
```

When finished, enter Control-Z to exit and save.

**Using Prices from a File**

A price file is a list of system resources and the prices you assign to each resource. The use of a price file gives you several advantages:

- You can create a price file with a text editor. This enables you to make corrections more easily than in a command line.
- You can specify the file name in the command, which eliminates the need to enter each price and enables you to reuse the price file for other reports.
- You can specify how the report will allocate the charges.
- You can create multiple price lists within a single file and then select the list to be used when you generate the report.

The rules for constructing a price file are

- Each line can begin in any column.
- The list contains keywords and their values. Most keywords may be preceded by identification information.
Specifying Resource Prices

- No more than one keyword specification can be placed on the same line, and no single keyword specification may be split across lines.
- Comment text is preceded by an exclamation point (!).
- Duplicate keywords are not allowed.

Overview and Example Price File

As shown in the following table, price file keywords fall into two categories: title or resource. Use the TITLE keyword to specify a title for your report and the resource keywords to specify prices for system resources.

This table shows an example price file that specifies all allowed keywords. The values shown are suggested as a starting point for creating a price list for your system.

<table>
<thead>
<tr>
<th>Title Keyword</th>
<th>Meaning</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TITLE</td>
<td>Optional report title</td>
<td>Title line is not printed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resource Keywords</th>
<th>Meaning</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUFFEREDIO_PRICE</td>
<td>Buffered I/O operations</td>
<td>0.00000</td>
</tr>
<tr>
<td>CPUSEC_PRICE</td>
<td>CPU time</td>
<td>0.00000</td>
</tr>
<tr>
<td>DIRECTIO_PRICE</td>
<td>Direct I/O operations</td>
<td>0.00000</td>
</tr>
<tr>
<td>ELAPSEDSEC_PRICE</td>
<td>Elapsed time</td>
<td>0.00000</td>
</tr>
<tr>
<td>FAULTIO_PRICE</td>
<td>Page read I/O operations</td>
<td>0.00000</td>
</tr>
<tr>
<td>GET_PRICE</td>
<td>Symbiont GET operations</td>
<td>0.00000</td>
</tr>
<tr>
<td>IMAGE_PRICE</td>
<td>Image activations</td>
<td>0.00000</td>
</tr>
<tr>
<td>MOUNTVOL_PRICE</td>
<td>Volume mounts</td>
<td>0.00000</td>
</tr>
<tr>
<td>PAGE_PRICE</td>
<td>Pages printed by symbiont</td>
<td>0.00000</td>
</tr>
<tr>
<td>PAGEFAULT_PRICE</td>
<td>Page faults</td>
<td>0.00000</td>
</tr>
<tr>
<td>PROCESS_PRICE</td>
<td>Process creations</td>
<td>0.00000</td>
</tr>
<tr>
<td>QIO_PRICE</td>
<td>Symbiont QIO operations</td>
<td>0.00000</td>
</tr>
<tr>
<td>PRINTJOB_PRICE</td>
<td>Print jobs</td>
<td>0.00000</td>
</tr>
<tr>
<td>DISKBLOCK_PRICE</td>
<td>Allocated block per UIC</td>
<td>0.00000</td>
</tr>
</tbody>
</table>
The following example is a price file showing one price for all accounting files:

```
TITLE = 'September's System Usage Charges'
BUFFEREDIO_PRICE = 0.00010
CPUSEC_PRICE = 0.01000
DIRECTIO_PRICE = 0.00050
ELAPSEDSEC_PRICE = 0.00005
FAULTIO_PRICE = 0.00050
GET_PRICE = 0.00010
IMAGE_PRICE = 0.01000
MOUNTVOL_PRICE = 1.00000
PAGE_PRICE = 0.02500
PAGEFAULT_PRICE = 0.00001
PROCESS_PRICE = 0.10000
QIO_PRICE = 0.00010
DISKBLOCK_PRICE = 0.05000
PRINTJOB_PRICE = 1.00000
```

**Specifying a Value for the Report Title Keyword**

The TITLE keyword allows you to create a string that is printed as the title on each page of the Charge report. This string can contain up to 80 characters.

If a string is not specified, no title line is printed. If more than 80 characters are specified, the title is truncated to 80 characters. Enclose the string in single quotes (') as shown in the following example:

```
TITLE = 'January's Cluster Resource Charges'
```

**Specifying Values for Resource Keywords**

Accounting Chargeback can produce a report from a number of accounting files with different resource prices for each accounting file. To do this, specify prices and identification information for resource keywords in a price file.

The table, later in this section, describes the resource keywords.

You assign a price to a particular resource according to the following format:

```
resource_price = value
```

For example:

```
BUFFEREDIO_PRICE = 0.00010
```

If no value is specified, the default is zero for that resource in all accounting files.
Identification information distinguishes the accounting file, printer, or disk for which a resource price is to apply. A category is a label that you use to select special prices to apply to resources. Much like a hotel price list might have different room prices for business travelers, for individuals, and for families, a price file can contain different prices for the same resources.

You use a category to link resource prices in the price file to specific accounting files. A category is a type of identification information that applies to all resource keywords except DISKBLOCK_PRICE. To use pricing categories:

1. Specify the category along with the keyword in the price file.
2. Specify the category along with the accounting file in the command line.

See the section, Invoking the ADVISE CHARGE_BACK REPORT Command, later in this chapter, which describes the use of categories in the ADVISE CHARGE_BACK REPORT command.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUFFEREDIO_PRICE</td>
<td>The price for each buffered I/O operation</td>
</tr>
<tr>
<td>CPUSEC_PRICE</td>
<td>The price for each second of CPU time used</td>
</tr>
<tr>
<td>DIRECTIO_PRICE</td>
<td>The price for each direct I/O operation</td>
</tr>
<tr>
<td>ELAPSEDSEC_PRICE</td>
<td>The price for each second of elapsed time between process creation and process deletion</td>
</tr>
<tr>
<td>FAULTIO_PRICE</td>
<td>The price for each disk read operation to bring into memory or a page fault cluster to satisfy a page fault. Typically, this keyword has the same value as DIRECTIO_PRICE</td>
</tr>
<tr>
<td>GET_PRICE</td>
<td>The price for each RMS $GET done by a print symbiont (on the user's behalf) to read a file being printed</td>
</tr>
<tr>
<td>IMAGE_PRICE</td>
<td>The price for each image activation</td>
</tr>
<tr>
<td>MOUNTVOL_PRICE</td>
<td>The price for each volume mount operation (handling cost)</td>
</tr>
<tr>
<td>PAGEFAULT_PRICE</td>
<td>The price for each page fault</td>
</tr>
<tr>
<td>PROCESS_PRICE</td>
<td>The price for each process creation</td>
</tr>
<tr>
<td>QIO_PRICE</td>
<td>The price for each $QIO done by a print symbiont (on the user's behalf) to send characters to the output device. Typically, this keyword has the same value as BUFFEREDIO_PRICE.</td>
</tr>
<tr>
<td>PRINTJOB_PRICE</td>
<td>The price for each print job in the specified printer queue</td>
</tr>
</tbody>
</table>
Specifying Resource Prices

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGE_PRICE</td>
<td>The price for each page of printed output for the specified. This keyword can be preceded by a printer queue name as well as a category.</td>
</tr>
<tr>
<td>DISKBLOCK_PRICE</td>
<td>The price for each allocated block per UIC for the specified disk. This keyword can be preceded by a volume name only and cannot be preceded by a category.</td>
</tr>
</tbody>
</table>

Identification information is specified depending on how resources are charged. Resources can be charged in the following ways:

- Identical resource prices can be charged for all accounting files.
- Different resource prices can be charged according to accounting files based on user-defined criteria such as processor types.
- Different prices can be charged for print pages according to printer queue name and accounting file.
- Different prices can be charged for disks based on volume names.

Each approach is described in the following sections.

Specifying Identical Prices for Accounting Files

The example in the section, Overview and Example Price File, earlier in this chapter, is a price file with one set of prices that can be applied to a number of accounting files. No categories are in this file; therefore, you do not need to specify categories in the ADVISE CHARGE_BACK REPORT command line. If a category is specified for an accounting file in the command, a warning message is displayed and price file prices are applied to that accounting file.

Specifying Different Prices for Accounting Files

A pricing scheme in which a resource’s price varies according to the accounting file is done through the use of categories. Categories are specified with resource keywords in the price file and with accounting files in the command line. The section, Invoking the ADVISE CHARGE_BACK REPORT Command, later in this chapter, describes how to specify categories in the ADVISE CHARGE_BACK REPORT command. In the price file, you specify different resource prices for each category in this format:

category::resource_keyword = value
The following is an example of pricing by category:

8800::BUFFEREDIO_PRICE = 0.20
2000::BUFFEREDIO_PRICE = 0.10
GREEN::BUFFEREDIO_PRICE = 0.30

Consider the use of categories for the COLOR VAXcluster system:

<table>
<thead>
<tr>
<th>Node Name</th>
<th>VAX Processor Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PINK</td>
<td>VAX 8800</td>
</tr>
<tr>
<td>AQUA</td>
<td>VAX 2000</td>
</tr>
<tr>
<td>PURPLE</td>
<td>VAX 8800</td>
</tr>
</tbody>
</table>

Resources on nodes PINK and PURPLE can be charged at a higher rate than the resources on node AQUA. Therefore, each resource in the price file is specified with one price for the category 8800 and one price for the category 2000, as shown in the following example.

This example illustrates a price file showing prices for two categories.

```
TITLE = 'System Resource Usage Charges for COLOR Cluster'
! Default Prices
BUFFEREDIO_PRICE = 0.00010
CPUSEC_PRICE = 0.01000
DIRECTIO_PRICE = 0.00050
ELAPSEDSEC_PRICE = 0.00005
FAULTIO_PRICE = 0.00050
GET_PRICE = 0.00010
IMAGE_PRICE = 0.01000
MOUNTVOL_PRICE = 1.00000
PAGE_PRICE = 0.02500
PAGEFAULT_PRICE = 0.00010
PROCESS_PRICE = 0.10000
QIO_PRICE = 0.00010
DISKBLOCK_PRICE = 0.05000
PRINTJOB_PRICE = 1.00000
!Prices for Nodes PINK and PURPLE 1
```
8800::BUFFEREDIO_PRICE = 0.00020
8800::CPUSEC_PRICE = 0.02000
8800::DIRECTIO_PRICE = 0.00060
8800::ELAPSEDSEC_PRICE = 0.00006
8800::FAULTIO_PRICE = 0.00060
8800::GET_PRICE = 0.00020
8800::IMAGE_PRICE = 0.02000
8800::MOUNTVOL_PRICE = 2.00000
8800::PAGE_PRICE = 0.05000
8800::PAGEFAULT_PRICE = 0.00002
8800::PROCESS_PRICE = 0.20000
8800::QIO_PRICE = 0.00020
8800::PRINTJOB_PRICE = 2.00000

Prices for Node AQUA 2
2000::BUFFEREDIO_PRICE = 0.00009
2000::CPUSEC_PRICE = 0.00900
2000::DIRECTIO_PRICE = 0.00040
2000::ELAPSEDSEC_PRICE = 0.00004
2000::FAULTIO_PRICE = 0.00040
2000::GET_PRICE = 0.00009
2000::IMAGE_PRICE = 0.00900
2000::MOUNTVOL_PRICE = 0.90000
2000::PAGE_PRICE = 0.01500
2000::PAGEFAULT_PRICE = 0.00001
2000::PROCESS_PRICE = 0.09000
2000::QIO_PRICE = 0.00009
2000::PRINTJOB_PRICE = 0.90000

1. When /CATEGORY=8800 is specified with accounting files in the ADVISE CHARGE_BACK REPORT command line, amounts for all resources preceded by the category 8800 in the price file are used to calculate values for those accounting files.

2. Similarly, when /CATEGORY=2000 is specified with accounting files, amounts for all resources preceded by the category 2000 are used to calculate values for those accounting files.

Default prices for resources without categories are applied to an accounting file for either of the following conditions:

- There is no category on the command line.
- The category specified does not correspond to categories in the price file.
For a better understanding of how resource prices are charged to accounting files, consider the resource prices specified in the next example.

The following example is a price file showing charges to accounting files:

```plaintext
TITLE = 'Resource Charges'
!
! Default Prices
!
BUFFEREDIO_PRICE = 0.00010
CPUSEC_PRICE = 0.01000
.
.
.
ELAPSEDSEC_PRICE = 0.00005
FAULTIO_PRICE = 0.00050
GET_PRICE = 0.00010
IMAGE_PRICE = 0.01000
MOUNTVOL_PRICE = 1.00000
PAGE_PRICE = 0.02500
PAGEFAULT_PRICE = 0.00001
PROCESS_PRICE = 0.10000
QIO_PRICE = 0.00010
DISKBLOCK_PRICE = 0.05000
PRINTJOB_PRICE = 1.00000
!
!
!Prices for NODEA
!
NODEA::BUFFEREDIO_PRICE = 0.00020
NODEA::CPUSEC_PRICE = 0.02000
.
.
.
NODEA::ELAPSEDSEC_PRICE = 0.00006
NODEA::FAULTIO_PRICE = 0.00060
NODEA::GET_PRICE = 0.00020
NODEA::IMAGE_PRICE = 0.02000
NODEA::MOUNTVOL_PRICE = 2.00000
NODEA::PAGE_PRICE = 0.05000
NODEA::PAGEFAULT_PRICE = 0.00002
NODEA::PROCESS_PRICE = 0.20000
NODEA::QIO_PRICE = 0.00020
NODEA::PRINTJOB_PRICE = 2.00000
!
!
!Prices for NODEB
!
NODEB::BUFFEREDIO_PRICE = 0.00009
NODEB::CPUSEC_PRICE = 0.00900
```
In the following example, the price file does not contain a price specification for the DIRECTIO_PRICE keyword; therefore, a price of zero is applied to all accounting files for direct I/O.

The categories specified in this example are NODEA and NODEB. When a category on the command line does not match any of the categories in the price file, the default price-file prices are used. For example, if an accounting file in the ADVISE CHARGE_BACK REPORT command has NODEC for a category, the resource prices without categories apply to that accounting file because NODEC does not match a category. That is, BUFFEREDIO_PRICE is 0.00010 and CPUSEC_PRICE is 0.01000.

The following message is displayed:

% PSAC-W-NOPRICE Default prices used for CATEGORY NODEC

Because no price is specified for direct I/O, zero is the default.

If an accounting file in the ADVISE CHARGE_BACK REPORT command has a category of NODEB, the prices specified for NODEB apply to that accounting file and the default prices are applied to all other resources. For example, BUFFEREDIO_PRICE is 0.00009 and CPUSEC_PRICE is 0.00900. With no entry under the NODEB category, ELAPSEDSEC_PRICE is the default price 0.00005. DIRECTIO_PRICE is charged as zero because no entry appears in the price file with this keyword.

### Specifying Different Prices for Print Pages

Just as you can choose from different queues for printing, you can charge different prices for printing based on the queue chosen. You can also charge different prices for printing based on account file categories. Accounting Chargeback lets you specify different prices for pages printed according to the printer queue name and accounting file category.

Specify categories and printer names according to the following format:

\[\text{category::printer_queue_name:PAGE\_PRICE} = \text{value}\]

This is an example of a page price with a queue name and category:

\[8800::SYS$PRINT\_LINE:PAGE\_PRICE = 0.0200\]

For example, you may want to charge more per page for documents printed on a PrintServer 40 laser printer than for documents printed on a line printer. This charge can vary from system to system, as shown in the following example.

If the page price keyword or its price is absent from the price file, the price of zero is applied to all of the print queues in any of the accounting files.
The example below illustrates price file page prices:

```
! Default Prices
!
.
.
.
PAGE_PRICE = 0.030001
!
! Default Prices by Queue
!
.
.
.
LASER_QUEUE:PAGE_PRICE = 0.0400
!
! 8800 Prices
!
.
.
.
8800::LASER_QUEUE:PAGE_PRICE = 0.05002
8800::SYS$PRINT_LINE:PAGE_PRICE = 0.0125
!
! 2000 Prices
!
.
.
.
2000::LASER.QUEUE:PAGE_PRICE = 0.0250
2000::SYS$PRINT_LINE:PAGE_PRICE = 0.0125
```

1 - If an accounting file has no category in the command line, the pages from the LASER_QUEUE are charged at $0.40 per page and all other pages printed are charged at $0.03 per page.

2 - If an accounting file has the category 8800, the pages from the LASER_QUEUE queue are charged at $0.05 and the pages from the SYSSPRINT_LINE queue are charged at $0.02. All other printer queues in this accounting file are charged at $0.03.
Specifying Different Prices for Allocated Disk Blocks

Accounting Chargeback lets you specify different prices for disks by volume name. Use the following format:

volume_name:DISKBLOCK_PRICE = value

The following is an example of different prices for different volumes:

SYS_DISK:DISKBLOCK_PRICE = 0.04500
USER_DISK:DISKBLOCK_PRICE = 0.05500
BACKUP_DISK:DISKBLOCK_PRICE = 0.05000

The following example illustrates a price file showing prices for different volumes.

TITLE = 'September's System Usage Charges'
BUFFERIO_PRICE = 0.00010
CPUSEC_PRICE = 0.01000
DIRECTIO_PRICE = 0.00050
ELAPSEDSEC_PRICE = 0.00005
FAULTIO_PRICE = 0.00050
GET_PRICE = 0.00010
IMAGE_PRICE = 0.01000
MOUNTVOL_PRICE = 1.00000
PAGE_PRICE = 0.02500
PAGEFAULT_PRICE = 0.00001
PROCESS_PRICE = 0.10000
QIO_PRICE = 0.00010
DISKBLOCK_PRICE = 0.05000 1
PRINTJOB_PRICE = 1.00000
SYS_DISK:DISKBLOCK_PRICE = 0.04500
USER_DISK:DISKBLOCK_PRICE = 0.05500
BACKUP_DISK:DISKBLOCK_PRICE = 0.07000

1 - Volumes that do not match a volume name in the price file are charged at the rate specified for the keyword DISKBLOCK_PRICE. In the previous example, a volume named BOOKS_DISK would be charged at the general price of $0.05000. If no general DISKBLOCK_PRICE is specified and the volume name does not match one in the price file, then the price of zero is applied.

To report charges for a disk, you must specify a disk usage file containing information for that disk in the ADVISE CHARGE_BACK REPORT command line as described in Invoking the ADVISE CHARGE_BACK REPORT command. Reporting on Disk Use Information describes how to include disk use information charges in your report.
Specifying Report Details in the Price File

In a report, charges can be grouped in different ways. To group charges, you select report details by entering qualifiers in the price file. The qualifiers are:

- JOBS
- JOBTYPES
- UICS
- USERS
- ACCOUNTS
- GRANDTOT
- NO_ZEROS_TOTALS

To select a report detail, enter the selection in the price file in this format:

PRINT_JOBS = TRUE

To omit a report detail, use this format:

PRINT_JOBTYPES = FALSE

The following example shows report detail qualifiers in a price file.

TITLE = 'System Usage Charges'
BUFFERIO_PRICE = 0.000100
CPUSEC_PRICE = 0.010000
DIRECTIO_PRICE = 0.000500
FAULTIO_PRICE = 0.000500
GET_PRICE = 0.000100
IMAGE_PRICE = 0.010000
MOUNTVOL_PRICE = 1.000000
PAGEFAULT_PRICE = 0.000010
PROCESS_PRICE = 0.100000
QIO_PRICE = 0.000100
PAGE_PRICE = 0.025000
PRINT_GRANDTOT = TRUE
PRINT_ACCOUNTS = TRUE
PRINT_USERS = TRUE
PRINT_UICS = FALSE
PRINT_JOBS = FALSE
PRINT_JOBTYPES = FALSE
Precedence of Qualifiers

Report details can be specified on the command line with the /DETAIL qualifier, as well as in a price file. Qualifiers specified on the command line override qualifiers in the price files. If report details are not specified, the defaults are GRAND, ACCOUNTS, and USERS.

The qualifier for reporting grand totals is specified differently depending on where it is used. You use GRANDTOT in a price file, but use GRAND in the command line. See Chapter 2, “Accounting Chargeback Commands,” for an explanation of the /DETAIL qualifier.

Invoking the ADVISE CHARGE_BACK REPORT Command

To generate a resource use report, enter a command of the form:

```
ADVISE CHARGE_BACK REPORT /qualifier[/...] account-file-spec[,...] -
[price-file-spec] -
[disk-usage-file-spec]
```

This command accepts three parameters:

**Account file-spec**

The name of the files containing accounting data. The account-file-spec is a required parameter that specifies the name of the file containing accounting data from the OpenVMS Accounting Utility. You can specify one or more accounting files.

**Price-file-spec**

The name of the chosen price file containing resource prices and report details. The price-file-spec specifies the name of the file that contains charges for each billable resource.

**Disk-usage-file-spec**

The name of the file containing disk use information. The disk-usage-file-spec specifies the name of a file containing disk use information from the OpenVMS Analyze/Disk_Structure Utility. Run this utility for each disk on which you want to report charges. Append the resulting output files to form one disk use file. This parameter is optional and need only be present for disk use reporting.

You can generate a report for a month, a week, or any period that you choose. Use the /ENDING and /BEGINNING qualifiers to specify the period of time for which charges are reported. See Chapter 2, “Accounting Chargeback Commands,” for a description of all the command qualifiers.
The following command generates a report, CHARGE.RPT, for the accounting data in ACCOUNT.DAT. Resource prices and report details are read from the price file ACCHARGE.TXT.

\$ ADVISE CHARGE_BACK REPORT ACCOUNT.DAT ACCHARGE.TXT

The following command generates a report, ACCOUNT.CHG, from the accounting data file ACCOUNT.DAT and the price file ACCHARGE.TXT. Because /DETAILS is given without any keywords, default details of GRAND, ACCOUNTS, and USERS are reported.

\$ ADVISE CHARGE_BACK REPORT/DETAILS/OUTPUT=ACCOUNT.CHG - _\$ ACCOUNT.DAT ACCHARGE.TXT

Entering the following command assumes that resource prices are defined for the categories GREEN and YELLOW in the price file CHARGE.DAT:

\$ ADVISE CHARGE_BACK REPORT ACCT1.DAT/CATEGORY=GREEN,ACCT2.DAT - _\$ /CATEGORY=YELLOW,ACCT3.DAT CHARGE.DAT DISK.DAT

The preceding command string indicates:

- Resource prices associated with the category GREEN are applied to the accounting file ACCT1.DAT.
- Resource prices associated with category YELLOW are applied to the accounting file ACCT2.DAT.
- Resources prices specified without categories in CHARGE.DAT are applied to the accounting file ACCT3.DAT. If there are no such resource prices, a price of zero is applied to all resources in ACCT3.DAT.
- The disk volume names in CHARGE.DAT have disk use information in the disk use file DISK.DAT.

Most of the error conditions that can occur when you generate a report are reported by standard error messages.

**Sample Report**

This section shows a sample report.

---

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 1

CHARGES.RPT

Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14

Type: Subprocess Single Job Total - File: 1

UIC: [1,4]

User: SYSTEM

Account:
Sample Report

Chapter 2: Using Accounting Chargeback

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price($)</th>
<th>Total Price($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Creations</td>
<td>2</td>
<td>0.10000</td>
<td>0.20</td>
</tr>
<tr>
<td>Image Activations</td>
<td>6</td>
<td>0.01000</td>
<td>0.06</td>
</tr>
<tr>
<td>CPU Time</td>
<td>00:00:03.22</td>
<td>0.01000</td>
<td>0.03</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>00:00:08.77</td>
<td>0.000000</td>
<td>0.00</td>
</tr>
<tr>
<td>Page Faults</td>
<td>586</td>
<td>0.00001</td>
<td>0.01</td>
</tr>
<tr>
<td>Page Read I/O Operations</td>
<td>20</td>
<td>0.00050</td>
<td>0.01</td>
</tr>
<tr>
<td>Direct I/O Operations</td>
<td>2</td>
<td>0.00050</td>
<td>0.00</td>
</tr>
<tr>
<td>Buffed I/O Operations</td>
<td>41</td>
<td>0.00010</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>0.31</td>
</tr>
</tbody>
</table>

Type: Interactive Single Job Total - File: 1

UIC: [1,4]

User: SYSTEM

Account: SYSTEM

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price($)</th>
<th>Total Price($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Creations</td>
<td>1</td>
<td>0.10000</td>
<td>0.10</td>
</tr>
<tr>
<td>Image Activations</td>
<td>8</td>
<td>0.01000</td>
<td>0.08</td>
</tr>
<tr>
<td>CPU Time</td>
<td>00:00:16.85</td>
<td>0.01000</td>
<td>0.17</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>00:01:41.30</td>
<td>0.000000</td>
<td>0.00</td>
</tr>
<tr>
<td>Page Faults</td>
<td>1327</td>
<td>0.00001</td>
<td>0.01</td>
</tr>
<tr>
<td>Page Read I/O Operations</td>
<td>95</td>
<td>0.00050</td>
<td>0.05</td>
</tr>
<tr>
<td>Direct I/O Operations</td>
<td>191</td>
<td>0.00050</td>
<td>0.10</td>
</tr>
<tr>
<td>Buffed I/O Operations</td>
<td>150</td>
<td>0.00010</td>
<td>0.15</td>
</tr>
<tr>
<td>Disks Mounted</td>
<td>1</td>
<td>1.00000</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>1.53</td>
</tr>
</tbody>
</table>

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 3

CHARGES.RPT

Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14

Type: Subprocess Single Job Total - File: 1

UIC: [1,4]

User: SYSTEM

Account:

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price($)</th>
<th>Total Price($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Creations</td>
<td>3</td>
<td>0.10000</td>
<td>0.30</td>
</tr>
<tr>
<td>Image Activations</td>
<td>14</td>
<td>0.01000</td>
<td>0.14</td>
</tr>
<tr>
<td>CPU Time</td>
<td>00:00:20.06</td>
<td>0.01000</td>
<td>0.20</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>00:01:50.07</td>
<td>0.000000</td>
<td>0.00</td>
</tr>
<tr>
<td>Page Faults</td>
<td>1913</td>
<td>0.00001</td>
<td>0.02</td>
</tr>
<tr>
<td>Page Read I/O Operations</td>
<td>115</td>
<td>0.00050</td>
<td>0.06</td>
</tr>
<tr>
<td>Direct I/O Operations</td>
<td>193</td>
<td>0.00050</td>
<td>0.10</td>
</tr>
<tr>
<td>Buffed I/O Operations</td>
<td>191</td>
<td>0.00010</td>
<td>0.02</td>
</tr>
<tr>
<td>Disks Mounted</td>
<td>1</td>
<td>1.00000</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>1.84</td>
</tr>
</tbody>
</table>

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 4

CHARGES.RPT
### Sample Report

**Usage Period:** 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14

**Grand Total**

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price($)</th>
<th>Total Price($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Creations</td>
<td>3</td>
<td>0.10000</td>
<td>0.30</td>
</tr>
<tr>
<td>Image Activations</td>
<td>14</td>
<td>0.01000</td>
<td>0.14</td>
</tr>
<tr>
<td>CPU Time</td>
<td>00:00:20.06</td>
<td>0.01000</td>
<td>0.20</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>00:01:50.07</td>
<td>0.00000</td>
<td>0.00</td>
</tr>
<tr>
<td>Page Faults</td>
<td>1913</td>
<td>0.00001</td>
<td>0.02</td>
</tr>
<tr>
<td>Page Read I/O Operations</td>
<td>115</td>
<td>0.00050</td>
<td>0.06</td>
</tr>
<tr>
<td>Direct I/O Operations</td>
<td>193</td>
<td>0.00050</td>
<td>0.10</td>
</tr>
<tr>
<td>Buffered I/O Operations</td>
<td>191</td>
<td>0.00010</td>
<td>0.02</td>
</tr>
<tr>
<td>Disks Mounted</td>
<td>1</td>
<td>1.00000</td>
<td>1.00</td>
</tr>
</tbody>
</table>

**Grand Total $ 1.84**

**Report Date:** 03-FEB-2008 15:57 PSAC Vx.x Page 4

**CHASES.RPT**

**Usage Period:** 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14

**Run Statistics:**

- **Accounting file(s):**
  - File Category: File name
    - 1 <default> ACC2.DAT

- **Number of accounting records read:** 4
- **Number of accounting records selected:** 3
- **Command Line:**
  - CHARGE BACK REPORT ACC2.DAT PRICE.DAT

**Image Performance Statistics:**

- ELAPSED: 0 00:00:00.95 CPU: 00:00:00.10 BUFIO: 10 DIRIO: 5 FAULTS: 66
Reporting on Disk Use Information

To include disk use information in your Accounting Chargeback report

1. Create a disk use file for the disks on which you wish to report by using the following command:

   `ANALYZE/DISK_STRUCTURE/USAGE=[output-file-spec] diskname`

   For example:

   `$ ANALYZE/DISK_STRUCTURE/USAGE=USER_DISK.DAT USER`

   If no file specification is given, the default output file name of USAGE.DAT is used.

2. Append the disk use files into one file using the commands shown in the following example:

   `$ APPEND DEVD.DAT,USER1.DAT,SYS_2.DAT DISKUSE.DAT`

   For your convenience, the Accounting Chargeback software provides a command procedure to run and append the files for all the disks on the system:

   `$ @PSAC$EXAMPLES:PSAC$DISK_USAGE.COM`

3. Specify values in the price file for the DISKBLOCK_PRICE keyword for the disks on which you wish to report. The following is an example:

   ```
   DEVD:DISKBLOCK_PRICE = 0.03000
   USER1:DISKBLOCK_PRICE = 0.02500
   SYS_2:DISKBLOCK_PRICE = 0.03500
   ```

4. Invoke the ADVISE CHARGE_BACK REPORT command and specify the following items:

   - Accounting file name
   - Price file name
   - Disk use file
   - At least one of the following keywords for the /DETAILS qualifier:
     - GRAND
     - ACCOUNTS
     - USERS
     - UICS

   The following is an example of a command to create a disk use report:

   `$ ADVISE CHARGE_BACK REPORT/DETAILS=(USERS,UICS,ACCOUNTS) ACCOUNT.DAT - _$ CHARGE.DAT DISKUSE.DAT`
Varying Accounting File Contents

By using OpenVMS Accounting Utility qualifiers, you can vary Charge Report contents. These qualifiers enable you to create accounting data files of the data items you select. This section describes how to charge different prices for resources by selecting data based on types, UICs, users, accounts, and so on.

Reporting on Specific Accounting File Components

To create an accounting file of specific records, use the following qualifiers to the ACCOUNTING command:

- /TYPE=(print,process)
- /OWNER
- /PROCESS, /UICS, /USERS, and /ACCOUNTS

See the OpenVMS Accounting Utility Manual for more information.

The following section is an example showing how to create files of data selected by user name.

Creating Data Files Based on User Name

To charge for resources based on user name:

1. Use the OpenVMS command ACCOUNTING with the /USER qualifier to create accounting files for the user names for which you want to vary resource prices.

   The commands in the following examples create three accounting files: one for users Romeo and Juliet, one for users Dickinson and J. Conrad, and the other for all the other user names.

   - This command selects records that match the user names Romeo and Juliet:
     
     $ ACCOUNTING /BINARY /USER=(ROMEO,JULIET) /OUTPUT=LOVERS.DAT
   
   - This command selects records that match the user names Dickinson and J. Conrad:
     
     $ ACCOUNTING /BINARY /USER=(DICKINSON,JCONRAD) /OUTPUT=WRITERS.DAT
   
   - This command selects all the records except those that match the usernames Romeo, Juliet, Dickinson, and J. Conrad:
     
     $ ACCOUNTING /BINARY /USER=("-",ROMEO,JULIET,DICKINSON,JCONRAD) - _$ /OUTPUT=OTHERS.DAT
2. Specify categories and resource prices in the price file for the three accounting files, as shown in the following price file segment.

   ! Lovers Prices
   LOVERS::BUFFEREDIO_PRICE = 0.0009
   LOVERS::CPUSEC_PRICE = 0.00999
   LOVERS::DIRECTIO_PRICE = 0.00049
   .
   .
   .

   ! Writers Prices
   WRITERS::BUFFEREDIO_PRICE = 0.00030
   WRITERS::CPUSEC_PRICE = 0.03000
   WRITERS::DIRECTIO_PRICE = 0.00080
   .
   .
   .

   ! Others Prices
   OTHERS::BUFFEREDIO_PRICE = 0.00010
   OTHERS::CPUSEC_PRICE = 0.01000
   OTHERS::DIRECTIO_PRICE = 0.00050
   .
   .
   .

3. Specify categories for each accounting file in the ADVISE Charge_Back REPORT command line, as in the following example:

   $ ADVISE Charge_Back REPORT LOVERS.DAT/CATEGORY=LOVERS,WRITERS.DAT -
   _$ /CATEGORY=WRITERS,OTHERS.DAT/CATEGORY=OTHERS CHARGE.DAT
Chapter 3: Using the DECwindows Motif Interface

This chapter describes how to use the Accounting Chargeback DECwindows Motif interface. The interface gives you an easier way to enter the ADVISE CHARGE_BACK command. You can select each parameter and qualifier individually and let the interface combine these elements.

This section contains the following topics:

- Starting the DECwindows Motif Interface (see page 31)
- Exiting from the DECwindows Motif Interface (see page 32)
- Controlling the DECwindows Motif Interface (see page 32)
- Selecting Data and Price Files (see page 33)
- Specifying Time Periods and Details for Reports (see page 35)
- Editing Price Files from the Customize Menu (see page 36)

Starting the DECwindows Motif Interface

To use the DECwindows Motif interface, you do not need to install Accounting Chargeback or have it running on a workstation. You run the software from a remote node or cluster.

To start the DECwindows Motif interface

1. Modify the workstation security to allow access by the remote node. Use the Customize menu from the Session Manager window.
2. Set host to the node or cluster where Accounting Chargeback is installed.
3. Enter this command:
   
   $ SET DISPLAY/CREATE/NODE=MYNODE

   MYNODE represents the node name of the workstation.

   Enter the following command:

   $ ADVISE CHARGE_BACK REPORT/INTERFACE=DECWINDOWS

   The Accounting Chargeback DECwindows Motif interface displays the main window, enabling you to select the task you want to perform.
The menus in the Accounting Chargeback main window enable you to do the following:

- Invoke Accounting Chargeback or terminate the interface
- Specify accounting data, disk use, and price files
- Select the time period and report details
- Create or edit the price file
- View Help

Exiting from the DECwindows Motif Interface

To exit from the Accounting Chargeback DECwindows Motif interface, pull down the Control menu from the main window and select Quit.

Controlling the DECwindows Motif Interface

Pull down the Control menu and release on the menu item you want. The Control menu enables you to:

- Create a report using the default report file name
- Create a report using a report file name you enter
- Quit the Accounting Chargeback DECwindows Motif session

Creating a Report

To create a report, release on the Create Report menu item. A dialog box displays the names of the accounting data, disk use, and price files, and creates a report under the default file name CHARGE.RPT. Whenever you enter a file name for this report, this name becomes the new default report name.

Creating a Report with a Specified File Name

To create a report, release on the Create Report As... menu item. The screen displays the dialog box shown in the following figure. This dialog box enables you to enter the file name for the report.
You can enter or change the file name for the report. Click on OK to create the report. Click on Cancel to return to the Accounting Chargeback main window without creating a report.

**Selecting Data and Price Files**

Pull down the Files menu and release on the menu item you want. The Files menu enables you to:
- Select accounting data files
- Select a price file
- Select a disk use file

**Selecting the Accounting Data Files**

The Accounting Files dialog box enables you to select the accounting data file or files, categories, and listing order.

**Accessing the Accounting Files Menu**

Pull down the Files menu and release on the Accounting Files... menu item. The figure below shows an example of a list of accounting files entered from the DECwindows Motif interface.

![Accounting Files Dialog Box](image)

**Entering File Names**

**To enter file names**

1. Type the file name specification for the accounting file on the blank line below Accounting File. The flashing cursor (I) indicates where you can type the file name. (If the cursor is not flashing, point to the cursor and click the left mouse button.)
2. To specify a category, point to the cursor below Category and click the left mouse button. Then type the appropriate category.
3. Click the left mouse button on Add. The file name appears in the list box.

4. Repeat this procedure to enter additional files.

   If you want to add an entry similar to an existing entry, you can copy the entry to the entry line. To copy, double click on the entry. The entry will appear on the entry line, where you can edit the entry to create a new entry.

   To remove a file name from the list, point to the name and click the left mouse button. Then click on Remove.

5. When the list is complete, click on Apply. The list is saved and the dialog box remains.

   If you click on OK, the list is saved and the dialog box is removed.

   Click on Cancel to cancel the edits made since the last OK. Click on Apply and remove the dialog box.

**Selecting the Price File**

If you have already created the price file you want to use, you can enter the name from the Files menu. To select a price file, release on the Price File...menu item. The dialog box is shown below:

![Price File Dialog Box]

Type the name of the price file and click on OK.

**Selecting the Disk Use Data File**

To select a disk use file, release on the Disk Usage... File menu item. The dialog box shown in the following figure is displayed.

![Disk Usage File Dialog Box]

Type the name of the file and click on OK.
Specifying Time Periods and Details for Reports

Pull down the Select menu and release on the menu item you want. The Select menu enables you to:

- Specify the time period
- Specify the report details

Specifying Time Periods

You can specify the day and time for the reporting period or select from standard time periods. To select a time period, release on the Time Period... menu item. The dialog box shown in the following figure is displayed.

![Time Period Selection Dialog Box]

You can select from the following time period options:

- Last calendar week
- Last calendar month
- Complete file (the entire time included in the accounting files)
- Specific period (a time period that you specify)

To specify a time period, click on the Specific period option menu and release on the selection you want. The selections are shown here:
To enter a specific period of time to be covered by the report

1. Enter the time period in the format shown in the figure below.
   a) Click on the Start Time text field and type the beginning date and time.
   b) Click on the End Time text field and type the ending date and time.
2. Click on OK. The days and times appear in the proper locations.

Report Details

To select report details, release on the Report Details.... menu item. The dialog box shown in this section is displayed. Click on the toggle buttons to select the report details that you want. When you have completed your selections, click on OK.

Editing Price Files from the Customize Menu

The Customize menu enables you to edit price files. Pull down the Customize menu and release on the Prices... menu item.

The Price File Editor dialog box is displayed
Working with Price Files

Pull down the File menu and release on the menu item you want. The File menu enables you to:

- Open an existing price file
- Save the edited file under the default price file name
- Save the edited file under a name you enter
- Apply the edited price file for use in the report
- Quit the menu

After specifying prices, you must select the Apply menu item to use the prices for the current report.

Selections for Editing Price Files

Pull down the Select menu and release on the menu item you want. The Select menu enables you to:

- Enter a title for the report
- Price system resources
- Price printer pages
- Price disk blocks
- Specify report details

Entering a Report Title

To enter a title for the report, pull down the Select menu and release on the Report Title menu . . . item. The dialog box shown below is displayed. Type the report name and click on OK.
Entering Prices for General Resources

To enter prices

1. Pull down the Select menu and release on the General Resources . . . menu item.
   The screen displays the window shown below.
2. Select Get from the Resource option menu.

   ![General Resources Window]

For each price you want to enter

1. Point to the Resource box and hold down the left mouse button. Release on the system resource you want.
2. Click on the line below Price and type the price.
3. Click on the line below Category. Then type the category you want. If you do not want to specify a category for the resource, leave this line blank.
   You can display the entries by category or by resource. Point to the List Order By: box and press and release on the choice you want.
4. To include your entry, click on Add.
   If you want to add an entry similar to an existing entry, you can copy the entry to the entry line. To copy, double click on the entry. The entry will appear on the entry line, where you can edit the entry to create a new entry.
To save the completed price list into a file, click on Apply.

The following figure shows some example prices and categories that have been entered.

![Image of a price list dialog box]

**Entering Prices for Printer Resources**

To enter prices, pull down the Select menu and release on the Printer Pages . . . menu item. You can display the entries by category or by queue. Point to the List Order By: box and press and release on the choice you want. The selections are shown in the following figure.

![Image of a printer pages dialog box]

**For each price you want to enter**

1. Click on the line below Price and type the price.
2. Click on the line below Category. Then type the category you want. If you do not want to specify a category for the resource, leave this line blank.
3. Click on the line below Queue. Then type in the queue name you want. If you do not want to specify an individual printer queue, leave this line blank.
4. To include your entry, click on Add.

   If you want to add an entry similar to an existing entry, you can copy the entry to the entry line. To copy, double click on the entry. The entry will appear on the entry line where you can edit the entry to create a new entry.
The following figure shows the printer page dialog box with some sample prices.

### Entering Prices for Allocated Disk Blocks

To enter prices, pull down the Select menu and release on the Disk Blocks... menu item. The following figure shows the Disk Blocks Dialog Box with some sample prices.

For each price you want to enter

1. Click on the line below Price and type the price.
2. Click on the line below Category. Then type the category you want. If you do not want to specify a category for the resource, leave this line blank.
3. Click on the line below Queue. Then type in the queue name you want. If you do not want to specify an individual printer queue, leave this line blank.

   You can display the entries by category or by queue. Point to the List Order By: box and press and release on the choice you want.

4. To include your entry, point to Add and release.

   If you want to add an entry similar to an existing entry, you can copy the entry to the entry line. To copy, double click on the entry. The entry appears on the entry line, where you can edit the entry to create a new one.
Entering Report Details

To select report details, pull down the Select menu and release on the Report Details menu item. The dialog box shown in the figure below is displayed.

To select a detail, click on the toggle buttons for the details that you want. If you do not specify any details, none will appear in the price file.

Qualifiers can be specified in the command line and in a price file. Report detail qualifiers specified in the command line override qualifiers in the price files. If report details are not specified, the defaults are GRAND, ACCOUNTS, and USERS.
Chapter 4: Accounting Chargeback Commands

This is a reference chapter for the Accounting Chargeback command syntax at the DCL level. Refer to the chapter Using the DECwindows Motif Interface page 31 for information about performing the Accounting Chargeback functions with the DECwindows Motif interface.

This section contains the following topics:

ADVISE CHARGE_BACK REPORT (see page 43)
ADVISE CHARGE_BACK SHOW VERSION (see page 46)

ADVISE CHARGE_BACK REPORT

Process accounting and disk data by applying values in the price files to generate a report.

Format

ADVISE CHARGE_BACK REPORT account-file-spec[,...] [price-file-spec] [disk-usage-file-spec]

<table>
<thead>
<tr>
<th>Command Qualifiers</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>/BEGINNING[=time]</td>
<td>/BEGINNING=beginning-of-file</td>
</tr>
<tr>
<td>/DETAILS[=(item[,...])]</td>
<td>See description</td>
</tr>
<tr>
<td>/ENDING[=time]</td>
<td>/ENDING=end-of-file</td>
</tr>
<tr>
<td>/INTERFACE[=option]</td>
<td>/INTERFACE=CHARACTER_CELL</td>
</tr>
<tr>
<td>/OUTPUT</td>
<td>/OUTPUT=CHARGE.RPT</td>
</tr>
<tr>
<td>/BEGINNING[=time]</td>
<td>/BEGINNING=beginning-of-file</td>
</tr>
<tr>
<td>/DETAILS[=(item[,...])]</td>
<td>See description</td>
</tr>
<tr>
<td>/ENDING[=time]</td>
<td>/ENDING=end-of-file</td>
</tr>
<tr>
<td>/INTERFACE[=option]</td>
<td>/INTERFACE=CHARACTER_CELL</td>
</tr>
<tr>
<td>/OUTPUT</td>
<td>/OUTPUT=CHARGE.RPT</td>
</tr>
</tbody>
</table>
Positional Qualifier | Defaults  
---|---
/CATEGORY=category_name | None

**Parameters**

**account-file-spec[, ...]**

Specifies the names of one or more accounting data files. This parameter is required.

If you specify more than one accounting file, separate the specifications with commas (,).

**price-file-spec**

Specifies the name of a price file containing the prices for each billable item.

To enter prices from the terminal rather than the price file, omit the price-file parameter from the command line. If the optional disk-usage parameter is specified, replace the price-file parameter with quotation marks (" ").

**disk-usage-file-spec**

Specifies the name of a file containing disk use information provided by the OpenVMS Analyze/Disk_Structure Utility.

This parameter is optional and need only be present for disk use reporting.

**Restrictions**

You must have access to accounting files.

**Prompts**

Enter price and control parameters below:

**Description**

The ADVISE CHARGE_BACK REPORT command processes the accounting and disk usage data with the price file containing resource prices. It outputs a report showing a detailed breakdown of charges by individual job or process, job type, UIC, user name, account name, and grand totals.
Command Qualifiers

/BEGINNING[=time]
Controls whether only those records dated later than the specified time are selected. You can specify an absolute time, a delta time, or a combination of the two. If you omit this qualifier from the command line or if you do not specify the time, records will be selected starting with the first record in the file.

Records are recorded in the accounting log file at time of process termination only. The beginning and ending times are bounds on these record times.

/DETAILS[=(item[, ... ])]
Specifies the report details to be printed. You can specify any of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBS</td>
<td>Reports on each individual job or process</td>
</tr>
<tr>
<td>JOBTYPES</td>
<td>Reports totals for each unique combination of account, user name, UIC, and job type. The job types are batch, detached, interactive, network, subprocess, and print</td>
</tr>
<tr>
<td>UICS</td>
<td>Reports totals for each unique combination of account, user name, and UIC.</td>
</tr>
<tr>
<td>USERS1</td>
<td>Reports totals for each unique combination of account and user name</td>
</tr>
<tr>
<td>ACCOUNTS1</td>
<td>Reports totals for each account</td>
</tr>
<tr>
<td>GRAND</td>
<td>Reports the grand total for each accounting file</td>
</tr>
<tr>
<td>NO_ZEROS_TOTALS</td>
<td>Does not print resource fields with zero unit prices</td>
</tr>
</tbody>
</table>

1 - Disk use is recorded by UIC. Disk use totals for a user or an account will occur only if the UIC associated with the user is in both the disk use file and the accounting file.

/ENDING[=time]
Controls whether only those records dated up to and including the specified time are selected. You can specify an absolute time, delta time, or a combination of the two. If you omit the /ENDING qualifier from the command line or if you do not specify the time, the last record in the accounting file will be the final record processed.

Records are recorded in the accounting log file at time of process termination only. The beginning and ending times are bounds on these record times.
/INTERFACE=DECWINDOWS

Starts the Accounting Chargeback DECwindows Motif interface. The default
/INTERFACE=CHARACTER_CELL enables you to enter the command as a DCL
command string.

/OUTPUT=[=file-spec]

Specifies the name of the report file. If you omit the /OUTPUT qualifier or the file
specification, then /OUTPUT=CHARGE.RPT is assumed.

Positional Qualifier

/CATEGORY=category-name

Use this qualifier only after the account-file parameter. This qualifier links a set of
resource prices in the price file with the specified accounting file through a common
category name.

Examples

$ ADVISE CHARGE_BACK REPORT ACCOUNT.DAT DECPS_CHARGE.TXT

This command generates a report, CHARGE.RPT, for the accounting data in
ACCOUNT.DAT. Resource prices and report details are read from the price file
DECPS_CHARGE.TXT.

$ ADVISE CHARGE_BACK REPORT/OUTPUT=ACCOUNT.CHG - _$ EXTRACT.DAT DECPS_CHARGE.TXT

This command generates a report ACCOUNT.CHG from the accounting data file
EXTRACT.DAT and the price file DECPS_CHARGE.TXT. Because the /DETAILS qualifier
is not in the command, default details of GRAND, ACCOUNTS, and USERS are
reported.

$ ADVISE CHARGE_BACK REPORT ACCT1.DAT/CATEGORY=GREEN, - _$ ACCT2.DAT/CATEGORY=YELLOW,ACCT3.DAT CHARGE.DAT DISK.DAT

In this command, the resource prices associated with the category GREEN are
applied to the accounting file ACCT1.DAT. The resource prices associated with the
category YELLOW are applied to the accounting file ACCT2.DAT. The resource prices
specified without categories in CHARGE.DAT are applied to the accounting file
ACCT3.DAT. If there are no such resource prices, a price of zero is applied to all
resources in ACCT3.DAT. The disk volume names in CHARGE.DAT have disk use
information in the file DISK.DAT.

ADVISE CHARGE_BACK SHOW VERSION

Displays the version of the Accounting Chargeback software.
Format

ADVISE CHARGE_BACK SHOW VERSION
Appendix A: Error Messages

This appendix describes the format of the online error messages. It explains how to view the list of messages and get help with errors.

The figure below shows the parts of a sample message.

The following table defines the severity codes that are assigned to messages.

<table>
<thead>
<tr>
<th>Severity Code</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>INFORMATIONAL: The software sometimes provides additional information about an action.</td>
</tr>
<tr>
<td>W</td>
<td>WARNING: The command may have performed some, but not all, of a requested action. Verify the command or output.</td>
</tr>
<tr>
<td>E</td>
<td>ERROR: The output or program result is incorrect, but the software will attempt to continue execution.</td>
</tr>
<tr>
<td>S</td>
<td>SEVERE: A fatal error occurred; the software terminates execution of the request.</td>
</tr>
<tr>
<td>F</td>
<td>FATAL: A fatal error occurred; the software terminates execution of the request.</td>
</tr>
</tbody>
</table>
To display messages from the DCL level (command line), enter:

```
$ HELP ADVISE CHARGE_BACK ERRORS identification-code
```

Each description includes an explanation and recovery procedure.

To view the list of all messages, enter:

```
$ HELP ADVISE CHARGE_BACK ERRORS
```

Messages are listed alphabetically by the identification code that precedes each message.
Index

A
Accounting
  See OpenVMS Accounting Utility • 28
ACCOUNTING command • 28
Accounting data
  selection of • 28
Accounting Utility
  for system resources • 9
ADVISE CHARGE_BACK REPORT command • 23
  /BEGINNING qualifier • 45
  /CATEGORY qualifier • 46
  /DETAILS qualifier • 45
  /ENDING qualifier • 45
  /INTERFACE qualifier • 45
  /OUTPUT qualifier • 45
  Processes accounting and disk data • 43
ADVISE CHARGE_BACK SHOW VERSION command • 46
ANALYZE/DISK_STRUCTURE command • 9, 27
  command procedure • 27

C
Category
  defined • 13
CHARGE.RPT • 23
Command format • 43

D
Data
  for disk use • 9
  for system resources • 9
DECwindows Motif interface
  exiting from • 32
  invoking • 31
  on remote node • 31
Defaults
  for prices • 13, 15
  for report details • 23
Disk blocks • 21

E
Error code explanation • 49

F
Fatal message • 49
Format of command • 43

I
Informational code explanation • 49

M
Messages
  format • 49
  getting Help • 49

O
OpenVMS Accounting Utility • 28
  for system resources • 9
  qualifiers • 28

P
Price file • 9, 12
  editing in DECwindows Motif interface • 36
  rules for • 11
  with different prices for allocated blocks • 21
  with different prices for printing • 19
  with price categories • 13, 15
  with report detail qualifiers • 22
  with report title • 13
Price list
  Price file • 12
Prices, interactive entry • 11
Print queues • 19

R
Recovery procedures • 49
Report details
  defaults • 23
  precedence of qualifiers • 23
  specified in command line • 45
  specified in price file • 22
Report time period • 45
Resource keywords
  specifying values • 13
S
Severity code explanation • 49

V
Version of software • 46

W
Warning code explanation • 49